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1 MX-ONE TRAFFIC MANAGER 

1.1 WELCOME 

Congratulations on your selection of the MX-ONE Traffic Manager, TM Application Suite, part of the 

Mitel solutions for enterprise networks. The communications solutions combine and improve advanced 

ways of exchanging information via voice, data, video, and evolving future media. 

1.2 TM APPLICATION SUITE 

The TM Application Suite software products are a comprehensive set of graphical PC-based tools that 

support all aspects of the MX-ONE operation and administration, including: 

• High-level telecommunications network supervision 

• Traffic measurement and reporting 

1.3 TRAFFIC MANAGER 

Traffic Manager provides a simple to use and flexible interface to managing the performance and 

optimizing the availability of the MX-ONE Service Node. With Traffic Manager, potential bottlenecks in 

the MX-ONE implementation can be avoided and system resources tuned to provide optimum 

availability. Traffic Manager consists of two sub modules; Data Manager and Presentation Manager, 

which is based on Microsoft Excel. 

Traffic Manager provides the MX-ONE administrator with the ultimate in usable, flexible, and easily 

understood information on the overall performance of trunks, routes, operators, individual extensions, 

and common system resources. Through the simple user interface of the Data Manager sub-module, 

performance data can be easily requested from the MX-ONE. This data is then automatically retrieved 

and stored as database files. 

With the Presentation Manager sub-module, the data can be easily viewed, modified, and presented in 

either report or graphic formats. Reports can easily be customized in both appearance and content, 

and then saved for future use. 

Traffic Manager also supports scheduling of reports for regular printing or electronic mailing within the 

organization. In this way, a complete overview of the MX-ONE can be constantly maintained in a user-

friendly format and potential problems can be avoided before they adversely affect the organization. 

1.4 RELATED DOCUMENTATION 

Traffic Manager Application Suite Technical Guide – This guide is written for technicians 

responsible for maintaining TM systems and TM Application Suite software. It includes detailed 

instructions on software and hardware installation, troubleshooting, system capabilities and limitations, 

and other technical topics. To open the Technical Guide help window, double click 

\MRS\HELP\TMTECHGUIDE.HLP in the MSP_C or MSP_S directory. 

Help – Data Manager help and Presentation Manager help provide detailed information for measuring, 

presenting, and analyzing MX-ONE traffic.  It provides complete feature descriptions and systematic 

instructions for both Data Manager and Presentation Manager. In Data Manager, select Contents and 

Index from Help menu. In Presentation Manager select Help from the PM menu. Click the 

Contents tab to scroll through a table of contents for the Help file. Click the Index tab to search for 

topics by using an index of Help subjects. Click the Search tab to use a full-text search for specific 

words or phrases. 
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1.4.1 FEATURES 

1.4.1.1 Data Manager 

Full Microsoft Windows graphical user interface with a common look and feel 

Setup and extraction of traffic data for: 

• Trunk Routes 

• Extensions(analog and digital only in this context) 

• Operators 

• Hunt Groups 

Multi-user environment for local and remote connections 

Automatic or manual extraction from MX-ONE 

Backup and restore of historical traffic measurement data for presentation access 

• Up to six months for primary database 

• Up to a year for auxiliary database 

On-line display of the MX-ONE feedback 

Drag and drop support 

Multi-MX-ONE configurations 

Daily system log files 

Full context sensitive on-line help 

1.4.1.2 Presentation Manager 

Simplified graphical user interface towards Microsoft Excel 

Fully customizable application 

Predefined reports for: 

• Operators 

• Trunk Routes 

• Extensions(Only Analog and Digital in this context) 

• Hunt Groups 

Graphic and summary reports 

Ability to manipulate chart data by editing existing traffic measurement data fields or adding/deleting 

traffic measurement data fields from the database table. 

Task Scheduler 

• Automatic printing of reports 

• Automatic mailing of reports 

• Capability to switch between accessing the primary of auxiliary databases. 

On-line help 
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2 STARTUP 

You can start Data Manager by one of the following methods. 

• From the Windows Start button 

You can launch Presentation Manager by one of the following methods. 

• From the Windows Start button 

• From Microsoft Excel 

2.1 TO START DM FROM THE WINDOWS START BUTTON 

1. Click Start on the Taskbar. 

2. Select ProgramsMTM Application SuiteData Manager. 

3. When the User Log On dialog box appears, enter your user name and password, select a server 

from the TM Server drop-down list, and then click OK. 

4. When your password is accepted, the Data Manager application interface will appear. 

2.2 TO START PM FROM THE WINDOWS START BUTTON 

1. Click Start on the Taskbar. 

2. Select ProgramsTM Application SuitePresentation Manager. 

3. When the Switch Nodes dialog box appears, select a server and a node to connect to. 

4. Choose the database you want to use. 

5. Click OK. 

6. Microsoft Excel starts with the PM menu and toolbar. 

2.3 TO START PMFROM MICROSOFT EXCEL 

Use this procedure to start PM from within the Microsoft Excel application. 

1. Click Start on the Taskbar. 

2. Select ProgramsMicrosoft Excel. 

3. Select Open from the File menu. 

4. In the Open dialog box, browse to c:\msp_c\pmg\bin or c:\msp_s\pmg\bin, select the PM.xla file, 

and click Open.  

5. Excel’s toolbars are replaced with PM’s toolbar and the PM menu is added to the menu bar 
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3 DATA MANAGER 

3.1 MAIN WINDOW 

After you log on to Data Manager, the main window appears. You use this window to connect to MX-

ONE traffic measurement nodes within your network. The Data Manager main window consists of a 

menu bar, measurements node selection, toolbar buttons, and a status bar. 

 

3.2 APPLICATION MENU 

TO CLICK 

Logon as a different user or change to another server. Change Current User… 

Replace your current access security password with a new one. Change Password... 

Select and connect to an individual traffic measurement node. Connect... 

End your connection to the current node (shown in the node selection 

window) and return to the main window. 

Disconnect 

Customize your data communications parameters, adjust MX-ONE 

connect delay, and character transmission timing. 

Communications... 

Review, modify, and delete DM/MX-ONE log files. Log Files... 

Configure basic DM operating parameters, save workspace on exit, 

create feedback logs, on-line/off-line operating mode, and polling time 

and server selection for automatic data extraction. 

Properties... 

Manually extract and update the Primary database, a task that is 

normally performed automatically.  

Update Primary Database... 

 

Store current traffic data and/or archived traffic data into auxiliary 

database. 

Setup Auxiliary Database... 

End your DM session. Exit 
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3.3 VIEW MENU 

TO CLICK 

Display and hide the toolbar. Toolbar 

Display and hide the status bar. Status Bar 

3.4 MEASUREMENT MENU 

TO CLICK 

Initiate a New Measurement. Initiate… 

Terminate the selected measurement. End 

3.5 WINDOW MENU 

TO CLICK 

Hide and display the traffic measurement command feedback window. Feedback Window 

Arrange open System Information and Feedback windows in stepped 

overlapping fashion, with the selected window on top.  

Cascade 

Use for sequential viewing. 

Arrange open System Information and Feedback windows in adjacent, 

non-overlapping fashion.   

Tile 

Use for simultaneous viewing. 

3.6 TOOLBAR 

You can use the toolbar to connect to measurement nodes and to start and stop measurements. 

Located just below the menu bar, the toolbar consists of a drop-down node selection window and a 

pair of buttons you can use to initiate and end measurements. 

3.6.1 NODE SELECTION WINDOW 

Click the drop-down control positioned just to the right of the node selection window to view a list of all 

available measurement nodes for which you have access authorization. Connect to the node you want 

by clicking its entry in the drop-down list. You can also select Connect... in the Application menu to 

connect to available nodes. 

3.6.2 INITIATE AND END MEASUREMENTS BUTTONS 

After you connect to a node you can modify existing measurement assignments or create new ones. 

Click the Initiate  and End  buttons to the right of the Node Selection window to open the Initiate 

New Measurement dialog box, or to end the selected measurement. 

3.7 SYSTEM INFORMATION WINDOW 

The System Information window appears after you select an available node. You may select a node 

by selecting Connect... in the Application menu, or from the toolbar’s Node Selection window. Select 

or double-click any node file folder symbol to view traffic measurement assignments for individual 

measurement objects. 
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3.8 MX-ONE FEEDBACK WINDOW 

As part of the main DM interface, the MX-ONE Feedback window allows you to monitor traffic 

measurement command and response dialog between DM and the MX-ONE. Select Feedback 

Window in the Window menu to open the command feedback window. 

3.9 STATUS BAR 

The Status Bar provides DM status and Help for each menu item, whether enabled or disabled. The 

left side of the status bar displays Help messages and the rightmost portion provides general DM 

status. 
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4 PRESENTATION MANAGER 

You can display and analyze traffic measurement data in Chart, Data, and Summary views. 

4.1 CHART VIEW 

Chart View gives you a high-level visual perspective of traffic measurement results.  You can 

compress and expand measurement intervals to narrow or broaden your focus on specific sets of data 

points. Depending on the kinds of measurements you are researching, you can select from a variety of 

chart types to enhance your evaluation of system performance. 

 

4.2 DATA VIEW 

In Data View, you are able to view the specific numerical values that produce your graphical Chart 

View presentations. Data View allows you to overlay and hide additional traffic data to better correlate 

cause and effect (resources versus performance, for example). You are also able to define custom 

reports based on PM’s pre-defined reports, and save your custom report definitions for future use. 

 

 



 

MX-ONE TRAFFIC MANAGER 1.4 – GETTING STARTED 

 

13/1531-ANF90115 Uen B3 2018-04-25  8 

 
 

4.3 SUMMARY VIEW 

Summary View aggregates measurements within a report in the form of percentages, averages, and 

totals. This view provides a comprehensive, quantitative summary of your report results. 

 

4.4 PM MENU 

Along with the standard Microsoft Excel menus for displaying, editing, formatting, and otherwise 

processing measurement values, a PM menu is included. However, only the PM menu belongs 

exclusively to Presentation Manager. This menu contains individual selections of feature controls and 

configuration options. The following table explains each menu selection. 

TO SELECT 

Select a report category, retrieve all corresponding measurements, and 

generate reports. 

Define Report... 

Add, modify, or delete scheduled reports. Scheduled Reports... 

Activate/deactivate the scheduler, set properties pertaining to your 

station regarding scheduled report print times, set your organization 

name, and schedule reports option, 

Profile Info... 

Select a server, node, and database. Switch Nodes... 

Confirm your intention to exit PM. Exit... 

Get Presentation Manager Help Topics. Help Topics... 

View version or release level information for the Presentation Manager 

you are running. 

About... 

4.5 TOOLBAR 

The toolbar provides mouse selection icons for major PM features and operations. You can display 

Windows ToolTips Help for each toolbar button by pointing with the mouse. These icons are grouped 

according to functionality, but are individually activated or deactivated, depending on the kind of traffic 

measurement data report you are viewing. 

4.5.1 REPORT PRINT ICON 

ICON DEFINITION 
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Print Reports 

Formats and sends your reports to your selected print output device.  

4.5.2 DEFINE REPORT ICON 

ICON DEFINITION 

 
Define Report 

Opens a dialog box where you can select the report category, name, 

grouping intervals, measurements, and date range.    

4.5.3 REPORT FORMAT ICONS 

Use these icons to modify the appearance and readability of your reports. Keep in mind that you can 

always use the Reset Chart Format button (see table below) to return to the original format. 

ICON DEFINITION 

 
Column Chart 

View 

Changes line and scatter charts to columnar format. Not accessible for 

distribution type reports. 

 
Line Chart View 

(Show Markers) 

Changes column or scatter charts to line chart view, with data point markers 

shown. 

 
Line Chart View 

(Hide Markers) 

Changes column or scatter charts to line chart view, with data point markers 

hidden. 

 
Scatter Chart 

View 

Changes column or line charts to scatter chart view (line chart data points 

without the connecting lines). 

 
Reset Chart 

Format 

Restores default PM chart format. 

 
Gridlines 

Adds horizontal gridlines to column, line, and scatter charts. 

 
Hide/Show Chart 

Legend 

Hides or displays legend information for report Chart View. The Hide 

command provides maximum chart area viewing. 

 
Automatic 

Labels 

Have Presentation Manager determine Chart View X-axis label orientation. 

 
Vertical Labels 

Forces Presentation Manager to apply vertical (stacked-letter) orientation to 

Chart View X-axis labels. 

 

 
Note! Certain Presentation Manager reports involve both the primary and secondary axes. The 

first four buttons (Column, Line, and Scatter View controls) apply only to the primary axis. 
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4.5.4 REPORT TIME INTERVAL ICON 

Presentation Manager report views support selectable query and display time intervals for most report 

types. This means that for a given span of report data, you can increase or decrease the density of 

information shown in Chart View, for example, by choosing smaller or larger report time intervals. 

Interval selections range from 15 minutes to months. 

ICON DEFINITION 

 
Change 

Grouping 

Interval 

Adjusts x-axis time division increments. Allows you to increase or decrease 

the density of information shown in Chart View. Also affects how information 

is presented in Data and Summary Views. 

4.5.5 REPORT TEMPLATE ICONS 

These controls allow you to customize Presentation Manager’s basic report templates to ideally suit 

your requirements. 

ICON DEFINITION 

 
Edit Fields 

Opens a dialog box where you can select additional fields, and enter a field 

title and formula. 

 
Hide Fields 

Removes any rows or columns on traffic measurement charts. Restore 

hidden fields with the Unhide All Fields toolbar icon. 

 
Unhide All Fields 

Restores all fields hidden with the Hide Fields toolbar icon. 

 
Save Custom 

Report 

Templates 

Saves and deletes custom report templates 

 
Custom Report 

Wizard 

Starts a Wizard that leads you through the steps of setting up a custom 

report. 

4.5.6 DATABASE QUERY NOW ICON 

When working in Data View, you can use report template controls to add, hide, and unhide data fields 

(measurement objects). The Query Now icon allows you to update your report accordingly as you 

make changes. 

ICON DEFINITION 

 
Query Now 

Updates your report with new SQL database information based on changes 

to data fields in the report template. Although you can only use this icon in 

Data View, query results are reflected in Chart View. 

4.5.7 PM TOOLBAR HELP 

This dedicated PMtoolbar Help icon provides point-and-click information on PM. 

ICON DEFINITION 

 
Help 

Click, drag, and click to call up context-sensitive help for on PM screen 

objects and controls. 
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4.5.8 QUITTING PM 

Presentation Manager operates within Microsoft Excel. Although Excel’s exit procedure closes 

Presentation Manager, you should always use Presentation Manager’s own exit procedure first: 

1. Select Exit... from the PM menu. 

2. Click OK to end your Presentation Manager session. 

4.5.9 QUITTING MICROSOFT EXCEL 

The “Quitting Presentation Manager” procedure leaves Microsoft Excel open. To quit Excel, close any 

other spreadsheets and active Excel sub-applications and select Exit from the File menu. 


